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Important Notice

The information contained herein is subject to change without 
notice. The only warranties for HP products and services are set 
forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for 
technical or editorial errors or omissions contained herein.

This document is delivered subject to the following conditions and 
restrictions:

This document contains proprietary information of HP Scitex (the 
"Company"). Such information is hereby supplied solely for the 
purpose of assisting authorized users of the HP Scitex FB7500 (the 
"System").

Without the express prior written permission of HP Scitex, no part 
of the contents hereof may be used for any other purposes, 
disclosed to any person or firm, or reproduced by any means.

The text and drawings herein are for the purposes of illustration 
and reference only. The specifications on which they are based are 
subject to change without notice.

The names HP, HP Scitex, and the HP logo are registered 
trademarks or service marks of Hewlett-Packard. The mark HP 
Scitex FB7500 is a trademark of the Company.
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Other company and brand, product and service names are for 
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trademarks of their respective holders. Data is subject to change 
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Disclaimer

The Company shall not be liable for any damages, costs and 
expenses (including, without limitation, damages in connection 
with bodily injuries, consequential damages and damages for loss 
of profits), incurred by the customer or by any third party, whether 
in action, in contract, tort or otherwise, arising out of, or in 
connection with, the System, its installation and/or operation, and 
any related accessories, products, parts, components or materials, 
except as, and to the extent, expressly specified in the applicable 
purchase contract.

Limited Warranty

The Company does not provide any warranty with respect to the 
System, its installation and/or operation, and any related accessories, 
products, parts, components or materials, except as, and to the extent, 
expressly specified in the applicable purchase contract.

Local Regulations

The customer is required to strictly follow the applicable 
international, regional, federal and state laws, regulations and 
standards, and nothing in this guide shall be construed as 
instructing or otherwise requiring or allowing the customer to 
violate such laws, regulations and standards. However, if and to 
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the extent permitted by law, in case of inconsistency or 
contradiction between any requirement or procedure contained in 
this guide and any such laws, regulations and standards, the 
customer shall follow the stricter between the requirements and 
procedures specified in this guide and the requirements and 
procedures specified in any such laws, regulations or standards.



Safety Hazard Warning Conventions

The safety hazard warning conventions used in this guide (and 
supplementary HP Scitex FB7500 documentation) are provided for 
the identification of safety hazards. They are used to identify 
conditions or actions for which a specific hazard is known to exist, 
and that may, cause personal injury and/or equipment 
malfunction.

The conventions are classified into the following categories: 
Danger, Warning, and Caution. Examples are shown below:

Danger Danger is used to identify conditions or actions for which a specific hazard is 
known to exist, and which will cause severe personal – or even fatal – injury, 
or substantial equipment damage. 

Warning Warning is used to identify conditions or actions for which there is a known 
risk, which may cause serious – or even fatal – injury.

Caution Caution is used to identify conditions or actions for which a potential hazard 
may exist, which will or can cause minor personal injury or equipment 
damage.

Other Conventions

The following conventions are used to draw your attention to 
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important points which are beyond or in addition to the regular 
information in this book:

Note Notes are used to identify an explanation, or provide additional information 
for purposes of clarification. 

Tip Tips provide useful shortcuts or recommendations.

Reference References are provided to refer you to further information in this document 
or another guide.



Acronyms

The following table displays frequently used acronyms:

Acronym Definition

CMYK Cyan, Magenta, Yellow, Black

LC, LM, LY, LK Light Cyan, Light Magenta, Light Yellow, 
Light Black

RGB Red, Green, Blue

DPI Dots per Inch

PS Postscript

EPS Encapsulated Postscript

ICC International Color Consortium

FSE Company Field Service Engineer

PDU Power Distribution Unit

UPS Uninterrupted Power Supply

UV Ultra Violet
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RIP Raster Image Processing

TIFF Tagged Image File Format

TIFF-BMP Tagged Image File Format - Bitmap
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Safety Instructions

Reference For the HP Scitex FB7500 safety instructions refer to HP Scitex 
FB7500 Operator Manual.

About HP Scitex FB7500 Printer
The HP Scitex FB7500 is a digital wide-format flatbed printer. It 
allows remarkably high quality printing on both rigid and flexible 
substrates up to 25mm thick in semi-automatic loading. 

The HP Scitex FB7500 utilizes drop-on-demand piezoelectric 
technology using ultraviolet (UV) curable ink. A family of UV 
FB221 curable inks prints on a wide variety of media, producing 
superior results even on difficult substrates.
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Figure 1-1   HP Scitex FB7500 Printer

High print speeds make the HP Scitex FB7500 printer ideal for 
printing medium and long runs of POP/POS applications within 
tight schedules, in fast-paced, demanding environments. Just what 
you need to increase your business agility and enhance your ability 
to take advantage of growth opportunities.



Features and Benefits

• The most cost-effective solution for POP jobs up to 250 copies 

• Intuitive workflow and short learning curve for screen printer 
operators

• Very high versatility in formats and media types - from paper 
sheets to thick (25 mm/1") boards

• Maximum printing speed of up to 500 m2/hr (5,380 ft2/hr)

• HP Scitex X2 print heads: the next generation print head for 
high-end printing systems

• High print quality for close-view POP applications, 6 colors 
with optional upgrades for 7th and 8th color

• 3/4 automatic loading mechanism

• Highly accurate registration for double-sided and backlit 
applications

Applications 

The range of applications you can print on the FB7500 printer is 
virtually unlimited. You can use it for: 

• POP/ POS displays
Chapter 1 - Introduction  3

• Indoor and outdoor signage

• Transit signage

• Interior design, furniture and architecture

• In-store advertising 

• Rigid building coverings 

• Museums, visitor centers, exhibitions 

• Theatre graphics 

• Construction and real estate signage 
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Figure 1-2  FB7500 Applications



Substrates 

Suitable substrates include: 

Rigid substrates - PVC, polycarbonates, corrugated cardboards, 
foam board, aluminum, styrene, acrylic, polyester, wood, ceramics, 
marble, and more 

Flexible substrates - banner, self-adhesive vinyl, paper, and more

Print Modes

The FB7500 printer offers a choice of different print modes to meet 
an enormous variety of general and special printing requirements. 
The FB7500 print modes are listed in Table 1-1.

Selection of the most suitable print mode depends on various 
factors, such as the specific print job application, the required 
viewing distance, and the media type.

Table 1-1  FB7500 Print Modes

Print Mode 
Resolution (DPI) Throughput

Full-Size
Sheets/hr Application

X 
Print

Y 
Cross Print m2/hr ft2/hr

POP 17 508 500 90 969 17 Near offset-quality 
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posters

POP 34 508 500 180 1,937 34 High definition POP

POP 34 Text 600 400 180 1,937 34 High definition POP 
jobs with file details

POP 42 400 400 220 2,367 42 Mainstream POP 

Production 63 400 400 330 3,551 63 2m view distance

Production 95 400 300 500 5,380 95 5m+ view distance



HP Scitex FB7500 Workflow

RIP Software

The RIP software is a part of the FB7500 workflow (see Figure 1-3) 
and plays an important role in color management, density 
adjustments, and the use of ICC profiles. 

The FB7500 printer is supplied without the RIP hardware, and it is 
the customer's responsibility to purchase the computer hardware 
required for the RIP software according to HP Scitex specifications 
provided in the HP Scitex FB7500 Site Preparation Guide. 

DTP I-RIP 
Macintosh or PC                                                                             

PS, EPS, PDF 1-bit TIFF

Network

RIP 
Station                                               

HP Scitex FB7500                         
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Figure 1-3  HP Scitex FB7500 Workflow
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General
The HP Scitex FB7500 system main components are:

• Printer (see Figure 2-1)

• Vacuum pump in the silence cabinet 

• Electrical cabinet

• UV system (UV electrical cabinet, UV cooler, UV blower)

• Dedicated RIP software

The FB7500 printer components are shown in the picture below.

Loader table

Loader

Unloader lift

Printing bridge

Printing table
Maintenance bath

SICK 
safety device 
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Figure 2-1   HP Scitex FB7500 Printer Components

Ink cabinet
Operator station



FB7500 Printer Directions and Axes

Figure 2-2  FB7500 Directions

The FB7500 printer has 7 motor-driven axes. The function of each 
axis is described in Table 2-1 on page 10.

Y
T

W 
M

S
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Figure 2-3  FB7500 Axes

X Z



Table 2-1  FB7500 Axes Functions

Axis Function

X-axis Printing table movement. 

Y-axis Bridge cross-print movement that determines the 
cross-print resolution.

Z-axis Bridge up and down movement. Up/down movement 
along the Z-axis is required to adjust the distance 
between the substrate and the print heads for different
substrate thicknesses.

T-axis Loading substrate onto the printing table.

W-axis Substrate alignment when loading it onto the printing 
table.

M-axis Opening/closing the UV lamp external shutters on the 
front side. 

S-axis Opening/closing the UV lamp external shutters on the 
rear side. 
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Printing Bridge
The FB7500 printing bridge contains the print heads and all of the 
peripheral systems supporting them, such as secondary ink tanks 
with taps, vacuum knife, water reservoir, two overflow boards, 
switch ink valves, UV lamp housing, UV lamp external shutter, UV 
fumes extraction duct, power distribution boards, PIC and ORCA 
electronic boards, purge manifold, water manifold, ink and water 
tubing, electrical cables, bridge lifting pistons, Y-axis, Z-axis, M-
axis, and S-axis motion systems. 

The bridge is covered with the upper and lower hoods. The 
printing bridge components and their location are shown in Figure 
2-4 to Figure 2-7.



Bridge upper hoods

Bridge lower hood 

Machine chassis

BLSC cabinet

Loader

Open bridge upper hoods 

UV fumes 
extraction 
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Figure 2-4  Printing Bridge with Closed/Open Upper Hoods

UV lamp housing

duct



Figure 2-5  Bridge Rear Side without the Lower Hood 

Electrical cables
Water 
reservoir

Ink tubing

UV external Secondary tanks

Bridge lifting piston Ink valves

with taps shutter
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UV lamp housing

Print heads power distribution boards

Fumes outlet

Media cooling fans 

ORCA boardPurge manifold

PIC board

Vacuum knife
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Figure 2-6  Bridge Top and Front Side Views

Overflow 
board

Water manifold 
for print heads
heating



The bridge contains the 312 print heads, 52 per color. All print 
heads are mounted on the ink bar and arranged in arrays. Each 
array contains 8 print heads which are connected to their PIC 
board. Each print head (in addition to the ink supply) includes an 
electronic package and a 26-pin male connector, as shown on 
Figure 2-16 on page 22. A set of registration pins ensures accurate 
positioning of print head modules with respect to each other and to 
the plate on which they are mounted. 

Figure 2-7  Eight Print Heads Connected to the PIC Board

For the maintenance procedures, the printing bridge should be 

PIC board

 Print head

Ink bar
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lifted using the two lifting pistons.

Caution To avoid curing of the ink while the bridge is in vertical position (during 
maintenance), the following guidelines are recommended:

• Do not position a light source directly above the printing bridge. If there 
is one directly above the printer, it should be turned off while the bridge 
is in vertical position for more than a few seconds. 

• The power density of a light source above the bridge should not exceed 
3mW/cm2.

• Sunlight is a real risk in case there is an open window that allows direct 
sunlight into the room and towards the exposed bridge. Make sure that 
such windows are shut. 

In general, if the bridge is left in vertical position for more than a few 
moments - it should be covered. 



Printing Table
The vacuum printing table major functions are:

• Advancing the substrate through the machine along the X-axis.

• Holding the substrate in place during printing.

Figure 2-8  Vacuum Printing Table

There are 4 registration pins on the printing table, which are used 
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for manual loading of the substrate (see Manual Substrate Loading 
on page 91). In this process, you press a pedal, which deactivates 
the vacuum to the printing table and raises the registration pins 
(see Figure 2-9 on page 16). Then, you place the substrate on the 
printing table and attach it to the registration pins.

The printing table is divided into the six sections. A vacuum 
manifold is located under the six sections. Switching between the 
Normal and Vacuum modes is done pneumatically.



Figure 2-9  Alignment Pins on the Printing Table

Ink System
The ink system controls the ink flow, and supplies ink to the print 
heads. The ink is supplied in disposable 5 liter plastic containers.

Note The ink containers can be replaced during the print run.
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The FB7500 ink system contains the following components:

For better understanding of the ink system operation refer to "Ink 
System Functional Diagram" shown in Figure 2-10.

• Ink containers

• Ink caps 

• Load cells

• Ink filters (5µ and 1µ)

• Ink pumps

• Print heads heating water 
system

• Circulation and Switch valves

• Secondary ink tanks with their 
taps 

• 2 overflow boards 

• Ink bars

• 312 print heads
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Figure 2-10  FB7500 Ink System Functional Diagram
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Reference For the ink system maintenance procedures refer to HP Scitex FB7500 User 
Safety and Maintenance Guide.

Ink Cabinet

The ink cabinet is located on the left side of the FB7500 printer (see 
Figure 2-1 on page 8). It contains 6 sockets for SMYK, LM and MC 
colors and 2 spare sockets.
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Figure 2-11  Ink Cabinet with Ink Containers

The load cells are 
located under the 
sockets (total of 8) and 
used for measuring 
the ink containers 
weight. This value is 
then converted into 
the voltage, sent to the 

machine computer and displayed in the FB7500 main window 
indicating the ink level (see System Status Section on page 82). 



The ink container is closed with a special 
cap, which prevents air from entering into 
the ink system.

For instructions on how to replace the ink 
containers, refer to Replacing Ink 
Container on page 97.

Secondary Ink Tanks
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Figure 2-12  Secondary Ink Tanks with Taps

The 12 secondary ink tanks (two per color) are mounted on the 
front and rear sides of the printing bridge. These tanks are filled 
from the ink containers with the help of the individual ink pumps 
and supply ink to the print heads through the ink bars.



Figure 2-13  Secondary Tanks Assembly

Tap

Secondary 
ink tank

Load cell
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Figure 2-14  Ink System Components

Ink pump

Ink filter



Ink Bars

The ink bars (one per color) are located on the printing bridge. Each 
ink bar carries 52 print heads, which are arranged in arrays. Each 
array contains 8 print heads, which are connected to their PIC 
board.

Figure 2-15  Ink Bar - Top View 

Ink inlets

Water inlets/outlet

Print head slot
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HP Scitex X2 Print Head

The X2 print head specifications are:

• 128 nozzles per print head, 64 nozzles on each side

• Native resolution: 100 dpi

• Drop rate: up to 30 kHz 

• Drop volume: up to 50pl

• Ink flux: more than 10ml/min

• Print speeds: up to 2 m/sec



Figure 2-16  HP Scitex X2 Print Head

Reference For instructions on how to replace the print head, refer to HP Scitex FB7500 
User Safety and Maintenance Guide. 

Print Heads Heating Water System 

The water system supplies hot water for heating the print heads. It 
contains the water reservoir, water pump, water manifold and 
water tank (see Figure 2-17, Figure 2-18, and Figure 2-19 

Nozzles

Electronic
package

26-pin electrical connector
              (to PIC board)

Ink ports
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accordingly). 

Figure 2-17  Water Reservoir



Figure 2-18  Water Manifold

Water manifold 

Water tank 
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Figure 2-19  Water Tank and Water Pump

Water pump 



Loading/Unloading System
The FB7500 loading/unloading system is a 3/4 automatic system, 
which controls loading and unloading of the substrate sheets. The 
system includes the loader, loader table, loader cabinet, and 
unloader lift.

Figure 2-20  Loading/Unloading System

Loader

Loader table
Unloader lift

Loader 
cabinet
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Loader Table

The loader table is a part of the loader. It is used for placing the 
substrate prior to automatic loading. 

Note The substrates should be placed one at a time. 



Loader

Loader cabinet Media 

Intake media

Static frame

NIP motor

Dynamic 

Loading 
suction cup 

Unloading 
suction cup 

pressure piston

piston

T-a
xis 

W-axis 

 NIP

Gripper
frame

Iron roller
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Figure 2-21  Loader Structure

The loader mechanism is comprised of the following components:

The dynamic frame grabs the substrate from the loader table, 
places it onto the printing table, and unloads it after the printing is 
complete.

• Dynamic frame

• Static frame

• NIP assembly

• 3 intake media pistons for 
rigid substrates

• 3 media pressure pistons for 
flexible substrates

• 3 loading suction cups

• 3 unloading suction cups

• T motor-driven axis 

• W motor-driven axis

• 2 grippers



NIP

The NIP is a part of the loading system and carries the functionality 
of aligning the substrate along the Y-axis before loading it onto the 
printing table. 

The NIP mechanism contains the following components:

• NIP roller - The NIP roller is activated when the substrate 
reaches the NIP’s two inlet sensors. The NIP roller advances the 
substrate towards the alignment fence. This is done by the 
intake media pistons (for rigid substrates) or media pressure 
pistons (for flexible substrates), which press the substrate 
against the NIP. 

• NIP inlet sensors (2 front sensors) - These sensors activate the 
NIP roller and the intake media pistons/media pressure 
pistons as explained above.

• Alignment sensors (2 rear sensors)- These sensors are located 
closer to the alignment fence and used for alignment relative to 
the Y-axis. 

Media Thickness Detector

The media thickness detector is a safety device located on the left 
side of the NIP. This detector compares the actual substrate 
26 HP Scitex FB7500 Advanced Printer Guide

thickness to the value entered in the Substrate Editor window (see 
Substrate Editor on page 59) and causes one of the following:

• If value measured by the detector is equal (with tolerance of up 
to + 0.8 mm) to the predefined value, loading continues and a 
message appears on the operator console. 

• If the value measured is higher or lower than the predefined 
value, printing is aborted.



Intake Media Pistons for Rigid Substrates

These pistons blow air on the substrate board 
against the NIP roller while the media advances 
from the loading table over the NIP roller. The 
pistons working pressure is 6 bars.

 

Figure 2-22  Intake Media Piston

Media Pressure Pistons for Flexible Substrates

These pistons press on the substrate board 
against the NIP roller while the media 
advances from the loading table over the 
NIP roller. The pistons working pressure 
is 6 bars.
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Figure 2-23  Media Pressure Piston



Loading/Unloading Suction Cups

The loading and unloading suction cups are 
mounted on the dynamic frame of the loader. The 
loading suction caps grab the substrate from the NIP 
and place it onto the printing table. Then the 
unloading suction cups remove the substrate from 
the table and place it onto the unloader lift. 

The loading suction cups move the substrate to left, 
along the W-axis. This alignment finally positions 
the substrate at 0,0 point on the X-axis, i.e. at the 
print start position.

Figure 2-24  Loading/Unloading Suction Cup

Loader Cabinet

The loading system is set and controlled from the dedicated loader 
cabinet (see Figure 2-26 on page 29). The loader cabinet is located 
under the loader table.

Loader table 
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Figure 2-25  Loader Cabinet Front View

Loading/Unloading system

Air pressure gauge for pistons 

Rigid/Flexible Media Selector 
Iron Roller Up/Down 

Air pressure regulator 

Power On/Off switch 



NIP motor

W-axis driver 

T-axis driver 

Unloader grippers

N/A Vacuum to Unloading

controller 

Thickness
detector 

Pressure 

unloading
suction cups 

Vacuum to
loading
suction cups 

suction cups valve 

Loading
suction cups valve 

gauges 
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Figure 2-26  Inside of the Loader Cabinet 



Loading/Unloading Sequence

1 The machine operators place the substrate onto the loader table. 

2 The NIP inlet sensors (2 front sensors) detect the substrate.

3 The system activates the selected set of pistons according to 
the Rigid/Flexible selector position.

4 The NIP roller advances the substrate. 

5 The alignment fence moves up.

6 The alignment sensors (2 rear sensors) detect the substrate. 

7 Substrate advance stops and the pistons, alignment fence and 
the NIP roller are deactivated.

8 The loading suction cups, located on the dynamic frame, move 
down and grab the substrate.

9 The loading suction cups move the substrate to left, along the 
W-axis to 0,0 point (print start point on the X-axis).

10 The loading suction cups move up.

11 The dynamic frame moves above the printing table.

12 The system activates the vacuum to the printing table (rigid 
substrates) or the 1st section of the table (flexible substrates).

13 Loading suction cups go up.
30 HP Scitex FB7500 Advanced Printer Guide

14 The system prints the image.

15 Unloading suction cups move down to the printed media.

16 The system deactivates the vacuum to the printing table.

17 Unloading suction cups grabs the substrate.

18 The dynamic frame moves above the unloader lift.

19 Unloading suction cups move down and place the printed 
substrate onto the unloader lift.

20 Unloading pistons go up.



Unloader Lift
The unloader lift is a surface where printed substrates are stacked 
on. At the end of every print run, after the substrate boards are 
stacked, the lift automatically moves down so as to be at an 
appropriate height for unloading the next board.

Unloader lift

Unloader cover
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Figure 2-27  Unloader Lift with Open/Closed Cover



Electrical Cabinet
The FB7500 electrical cabinet is positioned near the printer and 
contains the following components (see Figure 2-28):

• Machine computer

• Etherway boards

• Power supplies

• Safety controller

• Drivers

• Connectors’ panel

Machine 
computer

Etherway
boards Power supplies

Safety
controller
Safety
controller
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Figure 2-28  Electrical Cabinet

Drivers

Connectors’ 
panel



BLSC Cabinet
THe BLSC cabinet located on the rear side of the machine chassis. 
This cabinet contains I/O electronic boards (BLSC boards), Pumps 
board, purge air pressure regulator, and air pressure inlet valve 
(see Figure 2-29). 

Figure 2-29  BLSC Cabinet

BLSC boards Pumps board Purge air 
pressure regulator 

Air pressure 
inlet valve 
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Pneumatic System
The FB7500 pneumatic system supplies compressed dry air to the 
following subsystems:

• Printing bridge - bridge lifting pistons

• Printing table - pancake pistons and registration pins for the 
manual loading

• Loader/Unloader system - media pressure pistons, intake media 
pistons, media thickness indicator, iron roller, alignment fence, 
loading suction cups, unloading suction cups, and unloader 
grippers



• Maintenance system - purging manifold, vacuum knife pistons, 
and maintenance bath lifting pistons

The required pressure for the compressed air is 6 bars with a 
minimum flow rate of 120 liters/min (4.3 cfm). The compressed air 
inlet is located inside the machine in the rear left corner.

Figure 2-30  Compressed Air Main Pressure Regulator

Main 
pressure 
regulator

Compressed
air supply
connection
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Vacuum System
The main functions of the vacuum system are:

• Holding the substrate on the printing table - a unique vacuum 
system, especially designed to apply vacuum to the vacuum 
printing table along the X-axis (see Printing Table on page 15).

• Cleaning the print heads - as part of the maintenance system, a 
vacuum knife is used to clean the print heads (see Vacuum 
Knife on page 37).



The vacuum is generated by the vacuum pump (see Figure 2-31), 
which is enclosed within the silence cabinet and can be positioned 
outside the print production area.

Figure 2-31  Vacuum Pump in the Silence Cabinet
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Figure 2-32  Vacuum Inlet on the Printer’s Read Side 

Vacuum inlet 

Fumes extraction 
outlet 



Maintenance System
The FB7500 maintenance system includes the maintenance bath, 
vacuum knife, and vacuum separator.

Maintenance bath

Figure 2-33  Maintenance Bath

Maintenance bath
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During the print heads maintenance, the ink (spills and particles) 
and dirt are collected in the maintenance bath. From there, they 
drain into the waste funnel, located inside the machine, on its left 
side.

Waste funnel 

Drainage valve 



Vacuum Knife

The vacuum knife piston moves the vacuum knife along the Y-axis. 
The vacuum knife sucks dirt and ink dripping from the print heads 
(all six colors simultaneously).

Figure 2-34  Vacuum Knife

Vacuum Separator

The vacuum separator is user for separating air and dirt coming 

Vacuum knife

Vacuum knife 

piston 

Y-axis
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from the vacuum knife. Air is sucked into the vacuum pump and 
dirt is accumulated at the bottom of the separator.

Figure 2-35  Vacuum Separator

Vacuum inlet valve

Vacuum 
separator



Operator Console
The FB7500 printer’s operator console is mounted on the operator 
arm together with Safety lights, Service key and Emergency Stop 
button.

Safety lights

Operator console Service key

Emergency Stop

Operator arm

 button
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Figure 2-36  Operator Console

The Service key on the operator console is an Emergency Stop 
button with an additional feature. When the key is removed, the 
emergency mode cannot be canceled accidentally until the key is 
returned.

The Safety lights are used for indication of the machine status, as 
follows: 

Red light is On - machine initialization process or safety event.

Green light is On - machine is ready to print or printing.



Printer’s Computer 
The printer’s computer is located within the electrical cabinet (see 
Figure 2-28) and its configuration is based on the HP 8200xw 
workstation. 

Note Make sure that all cables are connected as shown in Figure 2-28. The wrong 
USB connection may cause failure of communication with the Weight and 
PILZ controller.

Power

COM to drivers

Mouse and 

USB to PILZ

Network to RIP

Keyboard

controller
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Figure 2-37  Printer’s Computer Connections

USB to Weight 
 Board

Display

CANBUS to
ORCA net

CANBUS to
BLSC net



Data Path
The data path components are:

• RIP station

• Machine computer

• Two Etherway boards

• 7 ORCA boards

• 42 PIC boards (7 PIC boards per color)

• 312 Print heads (52 print heads per color)
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Figure 2-38  FB7500 Data Path
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UV System
The UV system includes the following components:

• UV lamp housing 

• UV electrical cabinet

• Extraction fan

• UV cooler

• UV bulb

• UV Shutters

UV Lamp Housing

The UV lamp housing (see Figure 2-39) is located above the 
printing table.

Figure 2-39  UV Lamp Housing
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The UV lamp housing includes the following components:

• UV bulb

• Shutters

• Reflectors

• Quartz plate filter

• Air extraction windows

• Water tubes and ducts

The function of the UV lamp is to cure the UV ink on the printed 
substrate. During printing, the shutters are automatically opened, 
exposing the media to UV radiation, which cures the printed ink. 
At the end of the printing, the shutters are automatically closed.



UV Electrical Cabinet

Figure 2-40  UV Electrical Cabinet

The function of the UV electrical cabinet is to:

• Supply the required voltages to the UV system.
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• Supply the required voltages to the UV cooler.

• Supply the required voltages to the UV extractor fan.

• Control the UV lamp housing.

• Control the UV cooler.

• Control the UV extraction fan.



Extraction Fan

The function of the extraction fan (see Figure 2-41) is to:

• Remove heat from the UV lamp housing.

• Remove the generated ozone particles from the vicinity of the 
UV lamp housing.

Silencer

Extraction duct
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Figure 2-41  UV Extraction Fan

The extraction fan is controlled by the UV electrical cabinet and its 
flow rate is determined according to the UV lamp power.



UV Cooler

The UV cooler is located near the machine. The function of the 
cooler is to cool down the UV lamp housing by circulating distilled 
water through the system.

Output water 

Water level

Pressure of the

temperature

circulation pump

indicator
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Figure 2-42  UV Cooler (Front and Side View)
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FB7500 Main Window
The HP Scitex FB7500 user interface enables you to select files to be 
printed, set the printing parameters, perform a print run and 
maintenance cycle. During any stage of the printing process, you 
can view dynamically-updated print information at a glance.

To start the FB7500 application, click the FB7500 icon on your 
Desktop; the FB7500 main window appears. 
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Figure 3-1   FB7500 Main Window



The FB7500 main window is divided into the following sections, as 
shown in Figure 3-1:

1 - Main menu 
2 - Print controls 
3 - Jobs list 
4 - Preview and file information
5 - Maintenance and motion 
6 - Machine operations 
7 - Current Job 
8 - System status 

3

1

2
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Figure 3-2  FB7500 Main Menu Sections

4
5

6

7

8



Main Menu

The FB7500 main menu options and features are described in the 
following sections.

File Menu

Figure 3-3  File Menu

Option Used to...

Add New Job Add a new job to the Jobs List. For instructions refer to Adding a New 
Job on page 49.

Add Existing Job Add a new job to the Jobs List. 
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Edit Job Edit a job from the Job Properties window as described in Adding a New 
Job on page 49.

Delete Job Delete a job from the Jobs List. 

Exit Exit the FB7500 application.

Option Used to...
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Adding a New Job

1 In the File menu, select Add New Job; the Job Properties 
window appears. Within this window, there are three tabs: 
Layout, Job Info and Media Parameters. The Layout tab is 
displayed by default.



2 Click the  button, next to the Image box; the Choose Image 
File window appears.
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3 Click Folder Browser; the Browse window appears. 

4 Select the folder that contains the file separations and click OK; 
the Job Properties window appears again displaying the file’s 
preview and information, as shown in Figure 3-4.
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Figure 3-4  Job Properties - Layout Tab



5 Select the way of displaying the file preview (see Figure 3-4 on 
page 51): 

6 The Job name is named the same as the image by default, but 
you may change it to a different name at this stage. 

7 From the Print Mode list box, select the desired print mode. The 
FB7500 print modes are listed in Table 1-1 on page 5. 

The print mode determines the printing quality. It includes the 
printing table speed, resolution, print directions, number of 
passes, screen file, mask file, UV factor, and other parameters.

8 From the Substrate list box, select the substrate on which you 
want to print your file.

Upon selecting a specific substrate, the relevant information 
about it appears on the right side of the window: length, width, 
thickness, print heads height, and UV power.

Option Description

Img Shows the single file, enlarged to maximum size.

Lyt Shows the job dimensions relatively to the 
substrate dimensions. 
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Note All substrates are saved in a dedicated folder, which is an integral part 
of the FB7500 software. You may add new substrates from the Substrate 
Editor window (see Substrate Editor on page 59).

9 From the Method list box, select the printing method: Simple or 
Step&Repeat.

Method Description

Simple Each job is printed on one substrate sheet.
Under the Layout tab, enter the number of 
copies and the margins’ values.



Step&Repeat This is used when the printed job is smaller than 
the substrate sheet. In this method you may 
define the horizontal and vertical copies (on the 
single sheet and the number of sheets to print) 
and the gaps between them (see Figure 3-5). 

Method Description
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Figure 3-5  Job Properties - Step&Repeat



10 If needed, select the Job Notes box and enter the notes. These 

 Option Description

Copies per 
Sheet, 
# of Sheets 

Indicates the required number of copies. 
In Simple mode, the Copies per Sheet is equal to 
the # of Sheets.
In the Step&Repeat mode, the # of Sheets is 
calculated automatically by the application, 
making sure that the number of sheets will be 
enough to print the required copies. For example: 
if Copies per Sheet is 100 and 6 jobs can be 
printed on a single, the # of Sheets will be 17, 
and actual number of copies will be 102 
(17x6=102).

Margins A margin is the distance between the job edge 
and substrate edge. Margins may be added from 
all 4 sides: left, right, top and bottom.
Select the Center option (Horizontal and/or 
Vertical) to center the job on the media. In this 
case, margins will be automatically calculated.

Status Appears at the bottom of window, indicating if 
the Step&Repeat job fits the selected substrate.
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notes will be printed aside the printed image.



11 Click the Job Info tab (see Figure 3-6).

Figure 3-6  Job Properties - Job Info Tab
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Option Description

Annotations Enables printing of the selected annotations 
options aside the printed image.

Special marks Enables printing of the registration marks and 
crop marks.

Registration 
marks

Prints registration marks that can be used for 
double-side or backlit printing.

Crop marks Prints crop marks on the margins of the current 
job.



12 Click the Media Parameters tab (see Figure 3-7); the parameters 
of the selected substrate are displayed.

Figure 3-7  Job Properties - Media Parameters Tab (Normal)
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13 Select/deselect the Press Roller option to enable/disable the 
press roller, which was predefined in the Substrate Editor on 
page 59.

14 In the Appearance box, select the desired printed image 
appearance: Normal (see Figure 3-7), Semi Gloss, or Gloss (see 
Figure 3-8 on page 57).

Note Cycle is a single move of the printing table under the printing bridge.

Option Description

Advanced Opens the Appearance Editor window. Refer to 
Appearance Editor on page 61.



UV Power 
Forward

Defines UV intensity (40%-100% or Off) when 
the printing table moves forward (from right to 
left). 

UV Power 
Backward

Defines UV intensity (40%-100% or Off) when 
the printing table moves backward (from left to 
right). 

UV Extra Cycle Enables/disables curing (40%-100% or Off) after 
printing is complete. This option is used when 
the ink is not cured enough and additional 
curing (forward and/or backward cycle) is 
required. 

Option Description
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Figure 3-8  Job Properties - Media Parameters Tab (Gloss)



15 Click Save As and enter the job name.

16 Click Save and then Yes to save the job.

The job is displayed in the Jobs List with the Not Ready status. 

Tools Menu
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Figure 3-9  Tools Menu



Option Used to...

Substrate Editor Add a new substrate or edit parameters/remove an existing 
substrate. To enable this feature, open the Operator Level window 
and log on as Administrator.
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Print Mode Editor For R&D purposes only.

Preferences Set the preferences. For instructions, refer to Preferences on 
page 64.

Appearance Editor Define appearance of a printed image (Normal, Semi-Gloss, or 
Gloss). Refer to Appearance Editor on page 61. 

Calibration Settings Calibrate the FB7500 printer. For instructions refer to Calibration 
Settings - Heads V-Trimming Tab on page 66.



Operator Level

Define the level of accessibility for different users. Operator and 
Administrator are the user’s levels.

Customer List Editor

Option Used to...
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Create and manage a list of customers. This list is accessible in the 
Job Properties window, under the Job Info tab (see Figure 3-6 on 
page 55).



Appearance Editor

You can access the Appearance Editor from the Job Properties 
window (see Figure 3-7 on page 56) by clicking the Advanced 
button. 

The Appearance Editor enables you to adjust the appearance of a 
printed image. There are three possible appearance types: Normal, 
Gloss, and Semi Gloss. You may change settings of the appearance 
for the specific print mode or specific substrate, name it, and save 
for future use. You may rely on your own judgment when 
changing settings in the Appearance Editor to achieve the desired 
appearance. 
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Figure 3-10  Appearance Editor - Gloss



Note If you select Appearance Editor from the Tools menu, the Appearance Editor 
window opens for viewing only.

Note Cycle is a single move of the printing table under the printing bridge.

Option Used to...

Name Save the appearance settings under a specific name.

Type Select one of the appearance types: Normal, Gloss, or Semi-Gloss.

UV Timing Define at which cycle the UV lamp is On. For example, 1:7 determines 
that each seven cycles the UV lamp will be turned on.

UV Power 
Forward

Define the UV intensity (40%-100% or Off) for the printing table 
forward movement (from right to left). 

UV Power 
Forward

Define the UV intensity (40%-100% or Off) for the printing table 
backward movement (from left to right). 

Unidirectional 
Table Return 
Speed

Define the speed of the backward printing table movement in m/sec (for 
unidirectional print modes only). 
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UV Extra Cycle Enables/disables curing (40%-100% or Off) after printing is complete. 
This option is used when the ink is not cured enough and additional 
curing (forward and/or backward cycle) is required. 
Forward - Defines UV intensity (40%-100% or Off) during the forward 
movement.
Backward - Defines UV intensity (40%-100% or Off) during the 
backward movement. 
Table Speed - Defines the speed of the printing table.

Select Select one of the appearances listed on the left side of the window. 

Save As Save the new appearance settings under a new name.

Save Save changes for the existing appearance. 



The Appearance Editor window for the Normal type is shown in 
Figure 3-11.

Reset Reset all settings to defaults, i.e. to change back to their original 
settings.

Option Used to...
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Figure 3-11  Appearance Editor - Normal



Preferences

The Preferences window contains the three tabs: General, Quality 
and Additional Settings (see Figure 3-12).
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Figure 3-12  Preferences Window Tabs



 Option Description

Units Defines the measurement units (mm, cm or inch) 

UV Compensation In time the UV bulb radiation fades out, which can be indicated by 
insufficient ink curing. This option enables you to compensate the 
fade-out via the machine software.

Use Quality 
Enhancement 

Select this option to enable the quality enhancement tools

Quality Uniformity Select a Uniformity Profile to enhance the 
appearance of unified areas.

Wing Future option

Wing Width Future option

Noise Factor The algorithm that improves the image 
smoothness. However, if the applied value is 
more than 10%, it may increase the image 
graininess.

Nozzles 
Compensation

When selected, it enables compensation of the 
missing nozzles, also called MNC procedure, via 
the Calibration Settings window shown in Figure 
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3-15 on page 69. For instructions refer to Missing 
Nozzles Compensation (MNC) Procedure on 
page 98.

Motion Parameters For service purposes only.



Calibration Settings - Heads V-Trimming Tab

The Heads V-Trimming tab shows the print heads’ numbers and 
voltages applied to the specific print head of the specific color (see 
Figure 3-13).

Reference For detailed instructions on how to perform the Trimming procedure, refer 
to ACT-Trimming User Guide on the ACT DVD supplied in the FB7500 User 
Documentation Pack.
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Figure 3-13  Calibration Settings - Heads V-Trimming Tab



Calibration Settings - Import & Export Tab

This tab is used for importing the .meir file at the end the Trimming 
procedure and exporting/importing of the CalibrationDB.ini file. 
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Figure 3-14  Calibration Settings - Import & Export Tab

Reference For detailed instructions on how to import the .meir file, refer to ACT-
Trimming User Guide on the ACT DVD supplied in the FB7500 User 
Documentation Pack.



Option Description

Heads V-Trimming This option should be selected while importing the .meir file.

Import Imports the .meir file for the selected colors.
The .meir file contains voltage correction values that will be applied to 
the print heads to achieve uniformity between them and inside each 
print head. 

Calibration Setting 
Export

Saves the CalibrationDB.ini file in the desired folder. You may save 
the file under a different name. The CalibrationDB.ini file contains all 
machine settings created during the FB7500 Calibration Procedure.

Calibration 
Settings Import

Imports the CalibrationDB.ini file to restore the machine settings 
previously saved. 
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Calibration Settings - Nozzle Compensation Tab

This option should be activated from the Preferences => Quality tab 
(see Missing Nozzles Compensation (MNC) Procedure on page 98). 
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Figure 3-15  MNC Window

For instructions on the MNC procedure, refer to Missing Nozzles 
Compensation (MNC) Procedure on page 98.



Machine Menu

Option Description

Machine Settings - 
Colors Deactivation 
Tab

Enables you to deactivate specific colors. Once deactivated, the 
image will be printed out without that color.
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Other tabs are for the service purposes only.

Maintenance Performs a print heads maintenance (see Maintenance Window on 
page 73).

Machine Operation Opens/Hides the Machine Operations section on the FB7500 main 
window (see Machine Operations Section on page 81).

Motion For service purposes only.

Device Tree For service purposes only.

Task List For service purposes only.



Open Log Dialog

The Log Dialog contains information regarding the failed jobs: error 
ID, cause of a failure, time it happened, and filter.
Open this window to if you suspect a problem with the printer.
Buttons:
Clear Error - clears the error messages
Clear - clears all messages
Filters - opens the Statuses Filter window

Option Description
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Display Filter - future option
Multi Line - future option
Enable Logging - enables to view the Log Dialog window

Calibration Mode In the Calibration mode, clicking Open Existing Job shows the 
Calibration jobs only.

Diagnostics For service purposes only.



UV Operations

Switches on/off the UV system. The UV lamp, by nature, cannot be 
switched on or off instantly. It should be switched on at startup and 
switched off at the end of the work day. When the machine is in the 
Stand By mode, the UV lamp switches to the reduced power level of 
30% and its shutters are closed.

Media Setup 

Option Description
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Pressure Piston - used for the rigid substrates. 2 (or 3) pistons press 
the substrate against the NIP. 

Media Size - select this option to activate 3 pistons for the substrate 
sheets wider than 2.3 m

Load and Unload Test - used for checking if the loading/unloading 
system functions properly (see Loading/Unloading Sequence on 
page 30).



Maintenance Window

Option Description

Full Cycle Automatically performs a full print heads maintenance cycle. 
It is recommended to perform it with 2 sec. purge and Perform Wipe 
selected.

Purge Performs purge for the specified duration.

Prime N/A

Bath to Home Wipes the print heads with the vacuum knife after the purge.
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Circulation Off/On Removes air bubbles from the ink system.

Bath to Maintenance Moves the printing table to the left; then the printing table takes the 
maintenance bath to the position under the print heads.



Help Menu

Displays current FB7500 software version and Copyright.

Print Controls Section
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Option Description

Single This allows you to add several jobs to the list and set their printing 
parameters. The jobs will be printed one by one (one copy or more).

Queue Future option



Jobs List Section
The Jobs List section displays all the image files waiting to be 
printed with their status, print mode, and the number of copies. 

Print Job The printing process is described in Printing a Job on page 92. 

Stop Stops the current job after completing the current copy.

Abort Stops the print process immediately. 

Option Description
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Figure 3-16  Job List Section



Toolbar

Use the toolbar for managing the Jobs List.

Icon Function Use this icon to...

Add New Job Add a RIPed job to the list (same as Add New Job in the File 
menu).
After selecting the job and saving it, the job is automatically 
archived in a dedicated folder within the FB7500 application 
folder.

Add Existing 
Job

Add a job which was previously added to the list (same as Add 
Existing Job in the File menu).

Edit Job Review/change the properties of a job in the list (same as Edit 
Job in the File menu).

Proof Print one copy of the job, or a cropped portion of it for 
checking.

Activate Release a job from one of the following statuses: Hold, Pause, 
Stop or Abort.

Hold Disable the print of a job on the list.
To release the job from Hold status, right click the stopped job 
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and select Activate.

Up/Down Move a job on the list upward so as to print it earlier
Move a job on the list downward so as to print it later.

Remove Remove a job from the list.



Job Statuses

Every job on the Jobs List appears with its status, as follows: 

Prepare Job 
Offline

Prepare a RIPed job to print. In this "Offline Prepare" stage the 
bitmap separation's data of the job is nozzle-mapped, using a 
Mask file. In other words, the job's data is distributed among 
the print heads and the different passes/cycles. 
"Prepare Job Offline" should be activated manually by the user. 
Jobs that are prepared successfully switch to the "Ready" status.

Abort Prepare 
Job Offline

Abort a Prepare Job Offline process.

Icon Function Use this icon to...

Icon Status Description

Ready The job is ready to print, i.e. the job has passed the Prepare 
stage successfully.

Not Ready This is the status of a new job. The job has to pass the Prepare 
process, and only then it will be ready to print. 
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Preparing The job is in the "Prepare" process.

TBD Completed The job was successfully printed.

TBD Hold The job will not be printed (even though it was prepared 
successfully) until the user releases it from this status. To 
release the job from Hold status, right click the job and select 
Activate.

Failed The job failed to pass the Prepare process, or was aborted (by 
the user) in the middle of the Prepare process.



Job Options Drop-Down Menu

Figure 3-17  Job Options Drop-Down Menu

Option Used to...

Edit Open the Job Properties widow for changes (same as 
Edit Job in the File menu).

Proof Print one copy of a job, or a cropped portion of it for 
checking.

Activate Release a job from one of the following statuses: 
Hold, Pause, Stop or Abort.
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Change to 
Not-Ready

Future option

Hold Disable the print of a job on the list.
To release a job from Hold status, right click the 
stopped job and select Activate.

Prepare Job 
Offline

See Prepare Job Offline on page 77.

Up / Down Move a job on the list upward so as to print it earlier
Move a job on the list downward so as to print it later.

Remove Remove a job from the list.



Preview and File Information Section
The Preview window, located on the right side of the FB7500 main 
window, displays the selected image, together with general file 
information as seen in Figure 3-18.

The file information shown in this section is defined from the Job 
Properties window (see Adding a New Job on page 49).
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Figure 3-18  Preview and File Information Section



Maintenance and Motion Section

Current Job Section
This section allows visual indication of the job printing progress.

Option Description

Maintenance Opens the Maintenance window, see 
Maintenance Window on page 73.

Motion For service and R&D purposes only.
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Option Description

Print Speed Printing speed level.

# of Passes Number of passes.

Total Length Total image length that has been printed.



Machine Operations Section

 Tab Option Description

Main tab Manual Loading Refer to Manual Substrate Loading on page 91.

Automatic Loading Refer to Substrate Loading on page 91.

Lift Up Used to move up the unloader lift.

Lift Down Used to move down the unloader lift.
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Stop Stops printing upon completion of the current 
copy.

Move to Home Moves the printing table to its home position (to 
the right) for the automatic loading.

Move to End Moves the printing table to the left for the manual 
loading.

Arrows Continuously moves the printing table to the 
right/left.

Remove Media Automatically unloads the substrate sheet.



System Status Section

Vacuum tab Auto Vacuum The printing table areas are automatically 
activated according to the substrate size.

Area 1...6/All 
Areas

Activates the selected areas. 

Vacuum On/Off Activates/deactivates vacuum to the printing 
table.

 Tab Option Description

Option Description

Main Status The machine current status
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Substrate Substrate parameters

Ink Indication of the ink level in the ink containers

UV Settings Current UV system settings

General Free disk space
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C H A P T E R
4
Printing with FB7500

System Startup .................................................................. 84

Loading/Unloading System Setup...................................... 86

Substrate Loading ............................................................. 91

Manual Substrate Loading................................................. 91
.................................. 92

.................................. 93

.................................. 97

) Procedure .............. 98

................................ 101



System Startup
The HP Scitex FB7500 system startup procedure involves the 
following steps:

1 Visually check for:
• Ink leakage
• Loose connections
• Overheating components 
• Obstacles on the printing table

2 Perform general cleaning, as follows: 
• Clean the printer and the production area.
• Remove obstacles or foreign objects placed close to the 

printer.
• Check that the maintenance waste bath is clean.
• Clean the quartz filters in the UV lamp housing.
• Clean the printing table.

3 Prior to the system startup, check the following:
• Check the ink level in the main ink tanks.
• Make sure the air pressure in the main air pressure regulator 

is 6 bars.
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4 On the electrical cabinet, turn on the main power switch.

5 On the UV electrical cabinet, turn on the UV main power 
switch.
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6 Launch the HP Scitex FB7500 application; the UV system turns 
on automatically.



7 Wait until the Main Status is Ready and the button is green:

8 Perform a full print heads maintenance cycle: Maintenance -> 
Full Maintenance (see Maintenance Window on page 73).

9 Print the Head Signature to evaluate status of the nozzles. 
Follow the instructions in Missing Nozzles Compensation 
(MNC) Procedure on page 98). 
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Loading/Unloading System Setup
You should set up the loading/unloading system parameters each 
time you change the substrate. The preparation and setup 
procedure is described in the following sections. For better 
understanding of the unloading/loading system components, refer 
to Loading/Unloading System on page 24. 



Constant Parameters for All Types of Media 

Location of left loading suction cup: edge of profile

NIP speed: Max speed

Air pressure for media thickness detector: 1.5-2 Bars

Air pressure for unloader grippers: 3-5 Bars

NIP motor

W-axis driver 

T-axis driver 

controller 

Pressure 
gauges 
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Figure 4-1  Inside of the Loader Cabinet 

Unloader grippers

N/A Vacuum to Unloading

Media

detector 

unloading
suction cups 

Vacuum to
loading
suction cups 

suction cups valve 

Loading
suction cups valve thickness



Preparing the Loading/Unloading System for the Flexible Media

1 On the loader cabinet front panel set the selector valve to 
Flexible.

Figure 4-2  Loader Cabinet Front View

2 Use the white suction cups supplied in the Accessories Kit.

Rigid/Flexible Media Selector 

Air pressure gauge 

Air pressure regulator 

for pistons 
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Figure 4-3  Black and White Suction Cups

Note Unlike all flexible media types, Yopu requires the black suction cups. 



3 Position the two loading and two unloading suction cups at the 
edge of the substrate and one in the middle of it.

4 Using the pressure regulators inside the loader cabinet, adjust 
the air pressure (for creating vacuum) for the loading and 
unloading suction cups to 2-3 bars. 

5 Adjust the air pressure for the media pressure pistons in 
accordance with Table 4-1. 

Preparing the Loading/Unloading System for the Rigid Media

1 On the loader cabinet front panel set the selector valve to Rigid. 
See Loader Cabinet Front View on page 88.

Table 4-1  Air Pressure Values for Flexible Media

Media Air Pressure

You 3.2 x 1.6 2.4 bars

You 1.6 x 1.65 2.2 bars

SAV 1 x 1.4 2.1 bars

Paper 150gr 1.6 x 1.65 2.2 bars
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2 Use the black suction cups supplied in the Accessories Kit.

Figure 4-4  Black and White Suction Cups



3 For the substrate width up to 1.4 meter: position the two 
loading and two unloading suction cups, each at the edge of the 
substrate.

For the substrate width above 1.4 meter: position the two 
loading and two unloading suction cups at the edge of the 
substrate, and one in the middle of it.

4 Using the pressure regulators inside the loader cabinet, adjust 
the air pressure (for creating vacuum) for the loading and 
unloading suction cups to 4-5 bars. 

5 Adjust the air pressure for the intake media pistons in 
accordance with Table 4-2: 

Table 4-2  Air Pressure Values for Rigid Media

Media Air Pressure

Fluted 3.2 x 1.6 5 bars

Cardboard 3.2 x 1.6 5 bars

Foam PVC 2.4 x 1.2 5 bars

Cardboard 1.6 x 2.6 e/f 5 bars

Kappa (thk 5mm) 2.4 x 1.2 5 bars
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PVC (thk 5mm) 2.4 x 1.2 5 bars

Polystyrene (thk 5mm) 
1.6 x 1.6

5 bars

Compressed Cardboard 
(thk 2mm) 1.6 x 1.2

5 bars

Acrylic/Polycarbonate 
1.6 x 1 (thk 3mm)

5 bars

Cardboard 1.2 x 0.8 5 bars



Substrate Loading
In the 3/4 automatic loading, you should place the substrates on 
the loader table one by one and push them towards the loader 
entrance. The loader aligns and feeds them onto the printing table. 

If there is more than one copy, you may place the second substrate 
immediately after the loader has returned to its home position, 
even if the first substrate is still being printed (see Loading/
Unloading Sequence on page 30).

When the printing cycle is complete, the system automatically 
unloads the first substrate and stacks it on the unloader lift. 
Simultaneously, it feeds the second substrate onto the printing 
table. 

Manual Substrate Loading
In this method, the substrate is placed on the printing table 
manually, by the machine operator.

Attach the substrate
to registration pins 
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Figure 4-5  Manual Substrate Loading

Pedal



To load the substrate manually:

1 In the FB7500 main window, click Print Job; the printing table 
moves to the left.

2 Press the pedal; the system deactivates the vacuum to the 
printing table and raises the registration pins. 

3 Place the substrate on the printing table and attach it to the 
registration pins (see Figure 4-5 on page 91). 

4 Release the pedal; the system activates the vacuum to the 
printing table and lowers the registration pins. A message 
appears, asking you to confirm that the substrate is loaded 
properly. 

Click Yes to start the printing process.

Printing a Job
1 Set the loading/unloading system parameters for the selected 

substrate as described in Loading/Unloading System Setup on 
page 86.

2 Add a new job as described in Adding a New Job on page 49; 
the job appears in the Jobs List with the Not Ready status.

3 Select the job and click the Prepare Job Offline icon on the 
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toolbar; the job status changes to Ready.



4 Load the substrate sheet.

5 Click the Print Job button to start printing. 

System Shutdown
1 Exit the FB7500 application;

• The UV system shuts down automatically.
• All axes automatically move to their home position.
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2 Turn off the UV main switch on the UV electrical cabinet.

3 Turn off the Main Power switch on the electrical cabinet.

4 Drain the maintenance waste bath.

Morning Head Signature and Print Heads Maintenance
The Head Signature file is specially designed to check the print 
head nozzles for spraying uniformly and that none are clogged 
with the cured ink.

A test pattern enables you to easily determine the functioning of 
each of the print heads, and the condition of the nozzles in each 
print head. 



Print the Head Signature every morning before printing, or 
whenever you suspect that there is a problem with any of the print 
heads.
To print the Head Signature file:

1 Turn on the machine.

2 Perform a full maintenance cycle from the Maintenance 
window.

Figure 4-6  Maintenance Window

3 Make sure you have the latest CalPack 1.x files on D:\Jobs. 

If not, load the files from the latest CalPack included in the 
FB7500 Software DVD.
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Note Do not change parameters of any of the Calibration jobs!

4 From the machine application, select Machine =>Calibration 
Mode.

5 On the toolbar, click the  icon and select the Head Signature 
file.



6 Click the  icon to prepare the file and then Print Job.
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Figure 4-7  Head Signature Print Result

Note Do not forget to cancel the Calibration Mode before printing regular 
files. 

The print result contains the short line segments which are 
printed by each nozzle. A missing segment indicates a missing 
nozzle. As each nozzle prints, it is possible to trace misfiring 
nozzles since their corresponding line segments are missing 
(see Figure 4-8 on page 96). 



Perfect print head

Missing nozzle

Missing nozzle
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Figure 4-8  Missing Nozzles 

7 If necessary, perform a full maintenance cycle from the 
Maintenance window.



Replacing Ink Container
Replacement of the six 5-liter ink containers is performed as-
needed and can be done without interrupting printer operation.

Figure 4-9  Ink Containers’ Sockets and Ink Container

The ink level in the ink tanks is indicated in the FB7500 main 
window:
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However, it is recommended to manually check the ink containers 
every 8 hours.



Missing Nozzles Compensation (MNC) Procedure
This Missing Nozzles Compensation procedure (MNC) should be 
performed in case of a bad printing quality or after replacing the 
print heads. 

The reason for a bad quality could be clogged nozzles, nozzles 
firing aside (shifting), or not stable nozzles. These problems create 
quality problems such as micro banding. The MNC allows to 
eliminate these nozzles and compensate with others while printing. 

Limitation of this method is that not more than 5 nozzles per print 
head may be compensated. For example, the print head shown in 
Figure 4-10 has 7 missing nozzles. 

If you choose to replace such print head, refer to the Print Head 
Failure Approval Process in your Warranty Policy.
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Figure 4-10  Problematic Print Head 



To compensate the missing nozzles:

1 In the FB7500 main menu, select Tools => Preferences => 
Quality tab.

Figure 4-11  Quality Tab

2 Select the Use Quality Enhancements option.
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3 Select the Nozzle Compensation option and click OK. 

4 Print the Head Signature file (see Morning Head Signature and 
Print Heads Maintenance on page 93).

Figure 4-12  Signature of the Specific Print Head

Missing and shifting nozzlesPerfect Head Missing and shifting nozzlesMissing and shifting nozzlesPerfect HeadPerfect HeadPerfect print head Missing and shifting nozzles



Note Nozzles 1A and 16H might be missing but this is hard to detect. 

5 Select Tools => Calibration Setting => Nozzles Compensation. 

1

2

11

22
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Figure 4-13  Nozzle Compensation Tab

6 Mark all missing/problematic nozzles and click Apply. 

3

4

3

4



7 Perform the MNC for all problematic print heads.

For those print heads, which have more than 5 missing nozzles, 
refer to the Print Head Failure Approval Process in your 
Warranty Policy.

8 To evaluate the effectiveness of the whole MNC procedure, 
from the CalPack select the file that represents the print mode 
most commonly used at your site. The file name should be:

MNC_Detector_<print mode> _One_Color (or All_Colors) 

9 Print the file.

Note Set the margins to 0 on both axes (horizontal and vertical).

10 Perform steps 1 - 7 for all print heads.

11 Update the Nozzles Compensation tab accordingly.

Note After updating the Nozzles Compensation tab, your current jobs should be 
prepared again (via the Prepare Job Offline). 

Trimming Procedure

Reference For detailed instructions on how to perform the Trimming procedure, refer 
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to ACT User Guide on the ACT DVD supplied in the FB7500 User 
Documentation Pack.
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Current Job, 47
Current job, 80
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Full Cycle, 73
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G
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Head Signature, 93
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Heads V-Trimming, 66
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Ink, 82
Ink bar, 21
Ink container, 97

cap, 19
Ink containers, 18

replacement, 97
Ink system

components, 20
Intake media pistons for rigid substrates, 27

J
Job Info, 55
Job Properties, 53
Jobs List, 75
Jobs list, 47

L
Lift Down, 81
Lift Up, 81
Load cell, 18
Loader, 24

components, 25
structure, 24

Loader cabinet, 28
front view, 28
inside view, 28

Loader table, 24

Main pressure regulator, 34
Main Status, 82
Main tab, 81
Maintenance, 70

drainage valve, 36
waste funnel, 36

Maintenance and motion, 47
Maintenance bath, 36
Maintenance system, 36
Maintenance window, 73
Manual Loading, 81
Margins, 54
M-axis, 10
Media pressure pistons for flexible substrates, 
27
Media Setup, 72
Missing nozzles, 96
Missing Nozzles Compensation (MNC), 69
Motion Parameters, 65
Motor-driven axes, 9
Move to End, 81
Move to Home, 81

N
NIP alignment sensors, 26
NIP inlet sensors, 26
NIP roller, 26
Noise Factor, 65
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Loading/unloading sequence, 30
Loading/unloading suction cups, 28
Loading/Unloading system setup, 86

Flexible media, 88
Rigid media, 89

lower hoods, 10
Lyt, 52

M
Machine chassis, 11
Machine menu, 70
Machine Operation, 70
Machine operations, 47, 81
Machine Settings, 70
Main menu, 47
Main power switch, 85

Nozzle Compensation, 69
Nozzles Compensation, 65
Number of Passes, 80

O
Onix I-RIP, 6
Open Log Dialog, 71
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Operator Level, 60
ORCA, 40
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P
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Prepare Job Offline, 92
Preview and file information, 47
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Print head

specifications, 21
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Print Heads, 14
Print heads power distribution boards, 13
Print Job, 75
Print Mode Editor, 59
Print Speed, 80
Printing Bridge, 10
Printing section, 47, 74
Printing table, 15
Pumps board, 33
Purge, 73
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Quartz plate filter, 41
Queue, 74
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Status, 54
Step&Repeat, 53
Stop, 75, 81
Substrate, 82
Substrate Editor, 59
Suction cups, 28
System shutdown, 93
System startup, 84
System status, 47, 82

T
Taps, 12
T-axis, 10
Toolbar, 76

Abort Prepare Job Offline, 77
Activate, 76
Add Existing Job, 76
Add New Job, 76
Edit Job, 76
Hold, 76
Prepare Job Offline, 77
Proof, 76
Remove, 76
Up/Down, 76

Tools menu, 58
Total Length, 80
Trimming, 101
Trimming procedure, 66, 67, 101
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Reflectors, 41
Registration Marks, 55
Registration marks, 55
Remove Media, 81
RIP, 6

S
Safety, 2
Safety lights, 38
S-axis, 10
Secondary ink tank, 19
Secondary ink tanks, 12
Semi Gloss, 56, 61
Service key, 38
Single, 74
Special marks, 55, 57

U
Uniformity, 65
Units, 65
Unloader cover, 31
Unloader lift, 24, 31
Use Quality Enhancement, 65
UV bulb, 41
UV Compensation, 65
UV cooler, 44
UV electrical cabinet, 42
UV external shutter, 12
UV Extra Cycle, 57
UV extraction fan, 43
UV lamp

housing, 11
UV lamp housing, 13, 41



UV main power switch, 85
UV Operations, 72
UV Settings, 82
UV shutters, 41
UV system, 41

V
Vacuum knife, 13, 37
Vacuum On/Off, 82
Vacuum pump, 35
Vacuum separator, 37
Vacuum system, 34
Vacuum tab, 82

W
Water manifold, 13, 23
Water pump, 23
Water reservoir, 12, 22
Water system, 22
Water tank, 23
W-axis, 10
Wing, 65
Workflow, 6

X
X-axis, 10
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Y
Y-axis, 10

Z
Z-axis, 10
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